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INTRODUCCIÓN 
 

En el presente informe se describen las actividades realizadas por Evelyn Pamela 
Murguía Alemán, en su calidad de prestadora del servicio social el cual realizó 
durante el periodo comprendido que va del 30 de abril al 30 de noviembre del 2018. 
Las actividades se llevaron a cabo en el Laboratorio de Sistemas de Información 
Geográfica, perteneciente al Programa Universitario de Estudios Metropolitanos 
(PUEM) de la Universidad Autónoma Metropolitana Unidad Xochimilco. 
 
Los principales motivos que impulsaron el interés de realizar el servicio social en el 
PUEM, tienen que ver con fortalecer las capacidades profesionales adquiridas en el 
proceso de formación académica universitaria; aunado a la posibilidad de participar 
como prestador de servicios en la investigación aplicada que desarrolla el Programa 
y; el acercamiento a las Tecnologías de Información Geográfica a través del uso de 
Sistemas de Información Geográfica (SIG), tecnologías utilizadas en el LAB-SIG del 
PUEM.   
 

El informe se elaboró atendiendo los siguientes componentes: 
 
Investigación de la normatividad urbana aplicable a predios localizados en las 
demarcaciones de Tlalpan y Coyoacán. 
 
Consulta a bases de datos para identificar la intensidad de construcción en predios 
de las Alcaldías de Tlalpan y Coyoacán. 
 
Geoprocesamiento de ortofotos digitales  para la Ciudad de México 
 

OBJETIVO GENERAL 
 

Apoyar en los procesos de compilación, digitalización, normalización y 
sistematización de información geoespacial y alfanumérica. 
 
Apoyar en el geoprocesamiento de información geográfica y alfanumérica 
(proyecciones geográficas, codificación de datos y digitalización.  
 
Participar en la construcción de mecanismos para ampliar la difusión y consulta de 
datos. 
 
MARCO CONCEPTUAL DE REFERENCIA 
 
El presente apartado tiene la finalidad de mostrar algunos conceptos relacionados 

con las actividades elaboradas, en los que muchos de ellos se encuentran 

enmarcados en el uso de los Sistemas de Información Geográfica, los cuales como 

se indicó anteriormente, son una herramienta de análisis utilizada en el LabSig del 

PUEM. 
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Imagen urbana  
 
Conforme al artículo de Cullen (2012) la imagen urbana puede definirse como: 
 

“La imagen urbana se refiere a la conjugación de los elementos naturales y 
construidos que forman parte del marco visual de los habitantes de la ciudad, 
(la presencia y predominio de determinados materiales y sistemas 
constructivos, el tamaño de los lotes, la densidad de población, la cobertura 
y calidad de los servicios urbanos básicos, como son el agua potable, 
drenaje, energía eléctrica, alumbrado público y, el estado general de la 
vivienda), en interrelación con las costumbres y usos de sus habitantes”.  

 
Entender el concepto de imagen urbana, permitió desarrollar un análisis sobre una 
zona de estudio específica, como descripción del lugar, planos de fachadas, 
descripción de usos de suelo, perfiles de altura, normatividad urbana, el medio 
natural en el que se encuentra, así como las normas urbanas que se requieren para 
proceder a realizar un espacio urbano arquitectónico.  
 

Normas urbanas y usos de suelo  
 

De acuerdo al documento de Normas urbanas y legislación (2015), la “Ley Urbana 
Derecho Urbanístico, es el conjunto de políticas, leyes, decisiones y prácticas que 
rigen la gestión y el desarrollo del medio ambiente urbano...”  
 
Conforme al Artículo 3ro. de la Ley General de Asentamientos Humanos, 
Ordenamiento Territorial y Desarrollo Urbano, publicada en el Diario Oficial de la 
Federación el 28 de noviembre de 2016, describe los usos del suelo como “los fines 
particulares a que podrán dedicarse determinadas zonas o predios de un Centro de 
Población o Asentamiento Humano”, es decir, la ocupación de una superficie 
determinada de acuerdo a su potencial de desarrollo.  
 
Las normas urbanas decretan los usos al suelo conforme al desarrollo urbano que 
a su vez, limitan de forma legal las actividades sociales, es decir, la propiedad 
privada no puede utilizarse de forma distinta a lo que se impone por la Ley de 
Desarrollo Urbano del Distrito Federal (LDUDF).  
 
Existe la función de regulación de usos del suelo, que permite la construcción, 
constancias de uso del suelo que permite legalizar los usos generales de una 
propiedad en base a su uso actual, autorizaciones de fusiones y subdivisiones de 
terrenos, así como otras licencias ejercidas por las autoridades locales, de acuerdo 
a los programas de desarrollo urbano.  
  
Por otra parte, para comprender el proceso de la actividad de Ortomosaico de la 
Ciudad de México, es importante conocer los diversos sistemas que permiten 
adquirir las propiedades de una superficie en el menor tiempo posible, así como 
experimentar el espacio geográfico y las formas que existen para representar la 
superficie de la Tierra, se presentan los siguientes conceptos:  
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Proyecciones Geográficas o Cartográficas.  
 
Una proyección cartográfica es aquel proceso que se encarga de realizar una 
alteración sobre la superficie de la tierra, que al tener una forma de esferoide cuenta 
con las tres dimensiones, que con ayuda de cálculos matemáticos se realiza una 
transformación a una representación gráfica ortogonal conocida como mapa, por lo 
tanto las coordenadas geográficas originales (latitud–altitud) se convierten en 
coordenadas cartesianas (x–y), esto conforme a la Revista Geográfica Digital 
IGUNNE (2010).  
 
 “Los mapas geográficos son representaciones reducidas, generalizadas y 
matemáticamente determinadas de la superficie terrestre proyectada sobre un 
plano, en las cuales se interpreta la distribución, el estado y los vínculos de los 
distintos fenómenos naturales y sociales, seleccionados y caracterizados, de 
acuerdo con la asignación de cada mapa concreto” (Salitchev, 1981). 
 
“Los mapas facilitan la revelación de casi todos los fenómenos espacialmente 
manifestados, además son usados para buscar, comunicar, elaborara, interpretar y 
comunicar tanto aspectos como necesidades existan” (Veliz, 1991). La construcción 
de un mapa depende básicamente de los fines y usos para los que será elaborado; 
existen dos grandes clasificaciones de mapas, los cuales según su contenido y 
escala pueden dividirse en mapas de contenido geográfico general (por ejemplo, un 
mapa topográfico) y mapas de contenido temático donde se expresan fenómenos 
específicos o temáticos. 

 
Fotogrametría 

 
La fotogrametría según Hernández (2014):  
 

“Se define como el arte o la ciencia de realizar mediciones a partir del análisis 
de imágenes fotográficas, a fin de determinar las características métricas y 
geométricas de los objetos fotografiados; se basa en el principio de 
estereoscopia para transportar las imágenes obtenidas por medio de 
fotografías en segunda dimensión a imágenes en tercera dimensión para que 
puedan ser analizadas e interpretadas”. 
 

Este proceso se utiliza para adquirir información métrica como características físicas 
y naturales del objeto que se desea estudiar.  
 
Existen dos tipos de fotogrametría la aérea y la terrestre, de las que hace mención 
Hernández (2014) y las describe de la siguiente manera:  
 

“La fotogrametría terrestre que se desarrolla en cámaras métricas montadas 
sobre un trípode de manera que el eje óptico sea paralelo a la línea de 
horizonte, y la fotogrametría aérea que se desarrolla utilizando cámaras 
métricas colocadas en aeroplanos, ésta abarca mayor extensión de terreno”. 
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La fotogrametría terrestre se diferencia por la medición de las fotografías a nivel de 
suelo, donde se conocen las coordenadas del equipo y la orientación exacta del 
foco.  
 
La fotogrametría aérea es aquella que permite realizar mapas o planos tomadas 
desde el aire, mediante una cámara métrica colocada sobre un avión, que conforme 
a un plan, produce un número de capturas establecidas y con ciertas características 
donde se toma en cuenta el traslape para el efecto estereoscópico y la escala en 
las que se desea obtener cada imagen.  
 

Percepción Remota.  
 
De acuerdo al Instituto Nacional de Estadística y Geografía (INEGI), la percepción 
remota “es la ciencia (para algunos arte o técnica) que permite observar y obtener 
información de nuestro planeta –desde el espacio-sin estar en contacto con ella”. 
(INEGI, 2018).  
 
Para llevar a cabo el proceso de percepción remota, se debe tener una fuente de 
energía que será aquel que proporcione la energía electromagnética al objeto que 
se desea captar, ésta fuente suele ser el sol en muchos de los casos. La atmósfera 
y un sensor (montado vía satélite) van a jugar un papel importante, ya que van a 
interactuar entre sí, para que el sensor logre registrar la radiación electromagnética 
mostrada por el objeto y por la atmósfera, ésta energía captada se va a transmitir a 
una estación de recepción terrestre, donde se realiza un proceso de información y 
se transforman en imágenes digitales o conocidas también como imágenes 
satelitales.  
 
El último proceso es el de Ortofotos, procedimiento por el cual se realizó la actividad 
Ortomosaico que se describe en el apartado de Actividades Realizadas:  
 

Ortoproyección y Ortofotografía 
 
La ortoproyección es un sistema similar al de Proyección Cartográfica, donde la 
imagen digital representada tiene una vista cónica de la superficie terrestre y se 
transforma a una perspectiva ortogonal, que por medio de programas y 
herramientas especializadas se modifican las alteraciones, manteniendo la 
información topográfica correcta, permitiendo medir la escala a la que se encuentra, 
distancias y superficies del terreno. (Soria, 2014, p. 66) 
 
El procedimiento para transformar la imagen cónica a una ortogonal es a través de 
la ortorrectificación digital, que conforme al artículo del programa de cómputo ArcGis 
Pro: 
 

“La ortorrectificación es un proceso que corrige la distorsión geométrica 
inherente a las imágenes obtenidas mediante teledetección para generar una 
ortoimagen con precisión comparable a la de un mapa”.  
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Después de la ortorrectificación, la representación cartográfica va a adaptar los 
últimos detalles de la ortofoto como el ajuste de bordes, la generación de líneas de 
corte y el balance de color de varias imágenes para elaborar finalmente un dataset 
de ortomosaicos.  
 
Algunos de los sistemas anteriores pueden ser realizados a través de drones:  

 
Drones 

 
Santos (2014) en su tesis Fotogrametría usando plataforma aérea AUV, menciona 
que “Un dron es cualquier plataforma tanto aérea, terrestre y marina que no está 
tripulada y está controlada remotamente”.  
 
En el caso de los drones aéreos, existen dos tipos:  
 

“El primer grupo es el más común y el que lleva más años en el mercado son 
aparatos a radio control. Son aquellos que aun siendo sin piloto están 
dirigidos desde tierra por un piloto. Pueden ser controlados tanto a simple 
vista o para distancias largas con FPV (Visión en primera persona), se equipa 
la aeronave con una cámara que retransmite en tiempo real las imágenes. 
 
El segundo grupo es el más reciente. Es la propia aeronave la que sigue la 
ruta de vuelo gracias a un sistema de GPS con brújula que lleva integrado, 
son los denominados UAV (Unmanned Aerial Vehicle). Este sistema respecto 
al anterior permite unos vuelos más precisos y estables. Ideales para 
fotogrametría y teledetección”. (Santos, 2014, p. 7) 

 
Realizar fotogrametría con drones nos permite saber las propiedades geométricas 
de una superficie terrestre o marina a través de la captación de una cierta cantidad 
de imágenes, que al construirse o unirse permite conseguir la información 
necesaria, con base en el solapamiento, es decir, cada imagen debe tener 
elementos que contengan la imagen tomada anteriormente y la que incluirá la 
posterior. Y finalmente, con un programa especializado se vinculan todas las 
imágenes para formar la estructura completa de la superficie.  
 
Los resultados obtenidos son los siguientes tipos de imágenes: 
 

Imágenes satelitales  
 
Conforme a la página web del INEGI (2018), las imágenes satelitales son:  
 

“Una representación visual de los datos reflejados por la superficie de la tierra 
que captura un sensor montado en un satélite artificial. Los datos son 
enviados a una estación terrena en donde se procesan y se convierten en 
imágenes, enriqueciendo nuestro conocimiento de las características de la 
Tierra en diferentes escalas espaciales”.  
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Imágenes radar  
 
El artículo de la página web de Eduspace dice que “El radar se usa comúnmente en 
sistemas de control de tráfico aéreo, que guían a los aviones cualesquiera que sean 
las condiciones meteorológicas… Todos estos radares se usan para medir 
distancias y ángulos relativos para conocer la situación”.  
 
El sistema de radar es un tipo de sensor activo, porque cuenta con su propia fuente 
de iluminación, por lo tanto puede operar de día y de noche.  
 

“Los radares son sistemas activos: la escena que se va a "fotografiar" se 
ilumina, no con luz sino con señales electromagnéticas de una longitud de 
onda de microondas determinada. Las imágenes de microondas 
proporcionan información sobre las propiedades geométricas y dieléctricas 
de la superficie o volumen estudiado…” (Eduspace, página web) 

 
Las características de una imagen de radar son en blanco y negro, porque se 
realizan con una sola longitud de onda electromagnética de 5.3 cm. Sin embargo, 
conforme a Eduspace:  
 

“Se puede producir imágenes de radar en color combinando tres imágenes 
independientes de fechas distintas (por ejemplo, con 35 días de separación) 
formando una imagen compuesta multitemporal. Cada dato/imagen individual 
se muestra en uno de los tres colores usados para en la formación de 
cualquier imagen en color, es decir, el rojo, el verde y el azul. Las distintas 
cantidades de color de cada dato se combinan para producir otros colores 
que puedan interpretarse por procesadores expertos de imagen”.  
 

El sistema de radar tiene la máxima ventaja ante cualquier otro sistema satelital, ya 
que funciona en cualquier condición meteorológica, aunque ésta sea desfavorable 
y las veinticuatro horas del día, cuando otros satélites no pueden dar un servicio por 
depender de su fuente de energía, el sol.  
 
Por último, las ortofotos son resultado específico del proceso de Ortoproyección, 
que se describe a continuación: 

 
Ortofotos 

 
Conforme a la publicación de Valcarce (2013) en la página web Cartografía Digital 
“Las ortofotos son fotos aéreas del terreno, pero georreferenciadas en el espacio y 
rectificadas para ofrecer las mismas propiedades que un plano.”  
 
Para adquirir una ortofoto se requiere realizar el siguiente procedimiento, con base 
en la página web de la Consejería de Medio Ambiente y Ordenación del Territorio:  
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1. Vuelo fotogramétrico.- El aeroplano realiza las fotografías necesarias de la 
superficie que se desea.  

2. Digitalización de fotografías aéreas.- Se escanean las fotografías para 
obtenerlas en formato digital (Se utilizan escáneres fotogramétricos de alta 
precisión).  

3. Apoyo Topográfico.- Se rescata información de las coordenadas conocidas en 
las fotografías aéreas.  

4. Aerotriangulación (Orientación de fotografías).- Se conocen las posiciones 
de las fotografías en el momento en que se tomaron, para poder visualizar una 
imagen tridimensional del terreno.  

5. Obtención del Modelo Digital de Elevaciones.- A través de las fotografías 
aéreas se obtiene el relieve del terreno.  

6. Obtención de la Ortografía.- Con apoyo del Modelo Digital del Terreno se 
realiza el proceso de ortoproyección, es decir se genera una imagen 
georreferenciada y la escala del territorio.  

7. Mosaico de ortografías.- Se realiza el ajuste de tonalidad y luminosidad a las 
imágenes y al unirlas forman la Ortofotografía Digital o el Mosaico de 
Ortofotografías.  

 
Por último, es importante exponer que el INEGI realiza estudios con este sistema, y 
en su artículo hace mención de las diversas aplicaciones, donde su principal objetivo 
es “el estudio y aprovechamiento racional de los recursos naturales”. Y se puede 
aplicar en la geografía y cartografía, suelos, agricultura, bosques, ganadería, 
catastro rural y urbano, presas, vías terrestres, planeación, atención a 
contingencias, análisis de riesgo, evaluación de daños, estudios evolutivos y 
ordenación del territorio.  
 
ACTIVIDADES REALIZADAS 
 

En este apartado se describen las actividades desarrolladas conforme a los 
documentos realizados y al sistema de Ortoproyección que se utilizó para cumplir 
satisfactoriamente los objetivos.  
  

I. Análisis de imagen del tramo de Viaducto Tlalpan (de Acoxpa hasta 
Avenida San Fernando)  

 
Para esta actividad se realizó un documento escrito con el análisis de imagen 
urbana sobre la Avenida Viaducto Tlalpan teniendo como límites Avenida Acoxpa 
hasta Avenida San Fernando, con el objetivo de detectar todos aquellos elementos 
arquitectónicos y urbanos que permitieran la descripción de la zona para identificar 
el potencial de desarrollo urbano previsto en el Programa Delegacional de 
Desarrollo Urbano.  
 
El proceso de la actividad consta de la elaboración de un documento con un análisis 
de lo general hasta lo particular, empezando por realizar una observación detallada 
de la planeación urbana, percibiendo que el diseño urbano es el de malla o plato 
roto, es decir, las construcciones de edificios y calles se realizan de forma orgánica, 
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seguido de identificar la condición del paisaje urbano, donde se detectan parques, 
camellones y banquetas con un volumen bajo de vegetación y descuido, por lo que 
el enfoque del proyecto urbano, se centraría en estos espacios.  
 
Por último, se calcularon medidas para obtener alturas y determinar los niveles de 
construcción, notando que son variados, porque existen edificaciones de hasta 7 
niveles, pero en su mayoría son de 2 a 3 niveles.  
 
La segunda actividad es el seguimiento al análisis, con la elaboración de planos de 
fachadas de las construcciones.  
 

II. Elaboración de larguillos y comparación de perfiles de altura de 
Viaducto Tlalpan.  

 
Se realizaron larguillos que se componen de dos secciones poniente y oriente a lo 
largo de Viaducto Tlalpan, desde Calzada Acoxpa hasta Calzada México-
Xochimilco.  
 
El primer paso para la elaboración de los planos, fue medir el perímetro de los 
terrenos y las alturas de los niveles de cada una de las edificaciones, a través de 
Google earth, para proseguir a dibujar las fachadas en el programa de diseño 
AutoCad.  
 
Con los planos terminados, se llevó a cabo la comparación de perfiles de altura, por 
lo tanto se logró detectar una densidad constructiva media baja, donde la mayoría 
de los edificios construidos oscilan entre uno y cuatro niveles. Tan sólo seis edificios 
rebasan esos niveles, llegando hasta siete pisos.  
 
En la siguiente actividad se desarrolló un análisis de la zona de estudio con base en 
el uso de suelo programado, es decir, los designados por la Secretaría de Desarrollo 
Urbano y Vivienda (Seduvi).  
 
 

III. Análisis de Uso de suelo Programado.  
 
Para esta actividad se elaboraron tablas de distribución con base en los usos de 
suelo por colonia (divididas por delegaciones Coyoacán y Tlalpan, conforme a la 
zona de estudio), conforme los clasifica la Secretaría de Desarrollo Urbano y 
Vivienda de la Ciudad de México (Seduvi).  
 
Las tablas nos brinda la siguiente información: La superficie total del Polígono 
Urbano Regional tanto en hectáreas como en metros cuadrados, la cantidad de 
hectáreas y porcentaje que le corresponde a la alcaldía de Tlalpan y Coyoacán, así 
como a cada una de sus colonias.  
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Nos permite evaluar la cantidad total de predios existentes en la zona, el número y 
porcentaje de la distribución correspondiente al uso de suelo de cada uno de los 
predios (habitacional, habitacional con comercio, habitacional mixto, equipamiento, 
industria y espacios abiertos), indicando que el porcentaje mayor de predios le 
pertenece al uso habitacional.  
 
Analizar las especificaciones del ordenamiento territorial de la zona de estudio es 
de suma importancia, porque aporta los lineamientos contenidos en los 
instrumentos para normar y controlar el desarrollo y administración, así como apoyo 
para el diseño del Proyecto Urbano Arquitectónico.  
 
La actividad siguiente se relaciona con la especificación del medio ambiente del 
Polígono Urbano.  
 

IV. Descripción del medio natural de la zona de estudio 
 

Comprender el medio natural de la zona de estudio es significativo cuando se desea 
realizar un proyecto, ya que elementos naturales y artificiales van a interactuar entre 
sí y si el diseño no está bien planeado, los anteriores pueden verse modificados.  
 
Conforme al documento realizado, durante el servicio social, se estudian los 
siguientes aspectos del Polígono Urbano conforme a mapas ya elaborados:  
 
La edafología, que permite distinguir que predominan dos tipos de suelo: con mayor 
extensión es el suelo Feozem y el segundo es Litosol.  
 
En cuanto a la geología, se detectan cuatro clases de suelo que son el lacustre 
(ocupa aproximadamente la mitad de la superficie de los puntos este y sur), el aluvial 
(aparece como una franja central), basalto (abarca el oeste) y por último la toba.  
 
La zona de estudio es vulnerable ante fenómenos naturales como son los sismos, 
ya que se encuentra situada en la Zona III “Lacustre”, donde el coeficiente sísmico 
es intermedio y depende mucho de la fuerza con la que se presente el sismo.   
La actividad posterior se elaboró conforme al proceso de ortoproyección sobre el 
programa ArcMap.  
 

V. Elaboración de mosaicos del área metropolitana.  
 

El principal paso para el desarrollo de Ortomosaicos fue la introducción al programa 
de ArcMap.  
 
ArcMap es un programa que proviene de un software conocido como ArcGIS, 
Puerta, Rengifo y Bravo (2011) lo definen como:  
 

“ArcGIS es un “software” de Sistema de Información Geográfica (SIG) 
diseñado por la empresa californiana Enviromental Systems Research 
Institue (ESRI) para trabajar a nivel multiusuario. Representa la evolución 
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constante de estos productos, incorporando los avances tecnológicos 
experimentados en la última década en el área de informática y 
telecomunicaciones para capturar, editar, analizar, diseñar, publicar en la 
web e imprimir información geográfica”.  

 
De acuerdo a la página de ArcGIS, el SIG es:  
 

“Un sistema de información geográfica (SIG) es un sistema empleado para 
describir y categorizar la Tierra y otras geografías con el objetivo de mostrar 
y analizar la información a la que se hace referencia espacialmente. Este 
trabajo se realiza fundamentalmente con los mapas. 
 
El objetivo de SIG consiste en crear, compartir y aplicar útiles productos de 
información basada en mapas que respaldan el trabajo de las 
organizaciones, así como crear y administrar la información geográfica 
pertinente”. 

 
Existen dos formatos para operar los datos en el SIG son: vectorial, cuadrícula o 
raster. El primero, permite la entrada, almacena y maneja datos espaciales como 
puntos, líneas y polígonos o áreas con relación a las coordenadas x, y. El formato 
raster se caracteriza por ser una retícula formada por celdas localizadas por 
coordenadas; cada celda es ubicada independientemente con los valores de un 
atributo. 
 
Los SIG se emplean para trasmitir grandes cantidades de información de un terreno 
de forma organizada, identificar características específicas de una población, reunir 
y compartir información geográfica que se administra en geodatabases.  
 
ArcMap es un programa donde se puede trabajar con mapas para explorar su 
información, activar y desactivar capas, consultar entidades para acceder a todos 
los datos espaciales y ver su información geográfica.  
 
La actividad consistió en realizar un ortomosaico en formato raster, donde se realizó 
una edición en tres pasos, para reproyectar cada una de las imágenes satelitales 
fotografiadas de la Ciudad de México, que se encontraban agrupadas por 
cuadrantes, con base a un mapa llave formado en ArcMap. 
 
El primer paso fue definir una proyección para la imagen, donde ya se conoce el 
origen de su referencia espacial. Utilizamos la caja de herramientas de la aplicación 
y se realizó lo siguiente:  
 
ArcToolbox > Data Managements Tools > Projections and Transformations > Define Projection  

 
Dentro de la opción Define Projection se seleccionó el ráster para establecer la 
proyección deseada.  
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El segundo paso, fue reproyectar, es decir, aplicar un nuevo sistema de 
coordenadas:  
 
ArcToolbox > Data Managements Tools > Projections and Transformations > Raster > Project Raster   

 

En la opción de Project Raster se rellenan los campos necesarios como: 

 Input Dataset: Archivo shp de origen 

 Output Dataset: Ruta del directorio para salvar el shp 

 Pout Coordinate System: Seleccionar el nuevo sistema de coordenadas 
 
Donde se utilizó la zona geográfica: Norteamericana NAD27  
 
El paso anterior, se realizó nuevamente para redefinir el sistema de coordenadas:  
 
ArcToolbox > Data Managements Tools > Projections and Transformations > Raster > Project Raster   

 
Pero en este caso, la zona geográfica fue: Norteamericana WGS84.  
 
Finalmente la imagen se guarda en un formato TIFF. Puerta et al. encontraron que 
“es un formato creado por la empresa Aldus y Microsoft que puede almacenar 
imágenes en blanco y negro (1bits), tonos grises (4, 8, 16, 24 o 32 bits), seudo color 
(4, 8 o 16 bits) y color verdadero (24 bits). Mantiene la calidad de la imagen pero el 
archivo es muy pesado”.  
 

METAS ALCANZADOS 
 
Los objetivos propuestos para realizar el servicio social fueron satisfactorios y se 
lograron cumplir en tiempo y forma.  
 
Se entregaron reportes de análisis descriptivos e información alfanumérica para el 
desarrollo del anteproyecto análisis de normatividad urbana en el Corredor  Urbano 
Viaducto Tlalpan.  
 
Se consiguió apoyar con la captura, análisis, interpretación y almacenamiento de 
información geográfica, así como la representación de ésta, con el proceso del 
ortomosaico de la Ciudad de México con ayuda del programa ArcMap.  
 
RESULTADOS Y CONCLUSIONES 
 
El servicio social permitió completar con responsabilidad y compromiso la formación 
integral descubriendo mis potenciales, desarrollando habilidades y generando 
aprendizajes que me permitan integrarme fácilmente al trabajo profesional, a través 
del aprendizaje práctico.  
 
Los resultados que se obtuvieron de las primeras actividades relacionadas con la 
investigación de normatividad urbana que se aplica a los predios de las Alcaldía de 
Tlalpan y Coyoacán, fue la aportación con un plan adecuado para el Desarrollo 
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Urbano, donde se fomente, diseñen y protejan los espacios públicos seguros para 
la recreación y convivencia de los habitantes, donde la accesibilidad sea factible 
para cualquier persona, sea peatón, ciclista o una persona con discapacidad.  
 
El Geoprocesamiento de ortofotos digitales, deja como resultado la producción del 
mapa de la Ciudad de México, a través de la asignación de coordenadas 
geográficas y el aprendizaje del uso básico del programa ArcMap, que permite 
ampliar y emplear el conocimiento a un proyecto laboral.  
 
RECOMENDACIONES 
 
Que los proyectos de Servicio Social del Laboratorio de Sistemas de Información 
Geográfica perteneciente al Programa Universitario de Estudios Metropolitanos 
(PUEM) no sean asignados solamente a la carrera de Planeación Territorial, sino 
que también se designe a la carrera de Arquitectura, principalmente porque se 
desarrollan y fortalecen conocimientos poco vistos durante el curso y son dos 
profesiones que van ligadas en aspectos como el estudio y análisis de la zona.  
 
Que se realicen cursos para los prestadores de servicio social para aprender 
programas de procesamiento geoespacial o de diseño.   
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GLOSARIO 
 

A 
o Altitud. - Elevación o altura sobre el nivel del mar. 

o Aluvial. - Terreno que se ha formado a partir de materiales arrastrados y 

depositados por corrientes de agua. 

 

C 
o Conjugación. - Combinar dos o más cosas. 

 

D 
o Dataset. - Conjunto de datos. 

o Dieléctricas. - Propiedad con baja conductividad eléctrica que contiene un 

material. 

 
E 

o Edafología. - Ciencia que estudia la naturaleza del suelo en tanto que hábitat 
de las plantas. 

o Energía electromagnética. - Ondas de campos eléctricos y magnéticos que se 
propagan a través del espacio, y se trasladan a la velocidad de luz.  

o Erosión. - Desgaste y modelación de la corteza terrestre causados por la acción 
del viento, la lluvia, los procesos fluviales, marítimos y glaciales, y por la acción 
de los seres vivos. 

o Escala. – Relación que existe entre las dimensiones reales y las del dibujo que 
representa la realidad sobre un plano o un mapa 

o Esferoide. - Cuerpo geométrico de forma aproximadamente esférica. 
o Estereoscopia. - Técnica de grabación de la información visual tridimensional, 

es decir, la profundidad en una imagen.  
 
G 

o Geología. – Ciencia que estudia el origen, formación y evolución de la Tierra, 
los materiales que la componen y su estructura.   

o Georreferencia. - Técnica de posicionamiento espacial de una entidad en una 
localización geográfica única y bien definida en un sistema de coordenadas y 
datos específicos. 
 
I 

o Inherente. - Que es esencial y permanente en un ser o en una cosa o no se 
puede separar de él por formar parte de su naturaleza.  externo. 
 
L 

o Latitud. - Distancia angular que hay desde un punto de la superficie de la Tierra 
hasta el paralelo del ecuador; se mide en grados, minutos y segundos sobre los 
meridianos. 
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O 
o Ortogonal. – Que forma un ángulo recto.  

 
P 

o Precipitación. – Fenómeno meteorológico que consiste en la caída sobre la 
superficie terrestre de la humedad procedente de la atmósfera en estado líquido 
o sólido. 
 
R 

o Radiación electromagnética. - Combinación de campos eléctricos y 
magnéticos oscilantes, que se propagan a través del espacio transportando 
energía de un lugar a otro. 

o Relieve. - Configuración de una superficie con distintos niveles o partes que 
sobresalen más o menos. 

o Retrodispersión. - Este efecto se da cuando se toman fotografías bajo el agua, 
en las cuales, se puede ver pequeñas partículas iluminadas, como burbujas, 
suspendidas en la imagen. 
 
S 

o Sedimentación. - Es el proceso por el cual los materiales son transportados por 
distintos agentes (escorrentía, glaciares, viento) y procedentes de la erosión y la 
meteorización de las rocas son depositados, pasando a ser sedimentos. 

o Sismos corticales. - Son aquellos que se presentan en el interior de una placa, 
son considerados como sismos volcánicos. Éstos son subclasificados en Tipo A, 
B, C, E, ó F. Los sismos corticales tipo A ocasionan emisiones de baja frecuencia 
por lo que el daño es casi nulo, sin embargo, los demás tipos de sismos pueden 
llegar a tener consecuencias graves.  

o Subduce (Subducción). - Proceso por el que una placa litosférica oceánica se 
hunde bajo otra placa, ya sea oceánica o continental. 
 
T 

o Teledetección. - Detección a distancia de informaciones que se producen en la 
superficie de la Tierra y sobre otros astros solares y que se realiza mediante 
satélites y sondas artificiales. 

o Trípode. – Armazón de tres pies, generalmente articulados y plegables, que 
sirve para sostener ciertos instrumentos o aparatos. 
 
U 

o Uso de suelo. - Se refiere a la ocupación de una superficie determinada en 
función de su capacidad agrológica y por tanto de su potencial de desarrollo, se 
clasifica de acuerdo a su ubicación como urbano o rural.  

 
 
 
 
 
 



15 | P á g i n a  

 

BIBLIOGRAFÍA Y/O REFERENCIAS  
 
 ARCGIS [Programa de computador], Introducción a la representación cartográfica de 

ortofotos. Recuperado el 13 de noviembre del 2018, de https://pro.arcgis.com/es/pro-
app/help/data/imagery/ortho-mapping-in-arcgis-pro.htm 

 ARCGIS RESOURCES, Introducción a SIG, Esri. Recuperado el 12 de diciembre del 
3018, de http://resources.arcgis.com/es/help/getting-
started/articles/026n0000000t000000.htm 

 ARCMAP, Qué es ArcMap, Recuperado el 26 de noviembre del 2018, de 
http://desktop.arcgis.com/es/arcmap/10.3/main/map/what-is-arcmap-.htm 

 CARTOMAP. [Documento en formato PDF]. Ortofotos. Recuperado el 13 de noviembre 
del 2018, de http://cartomap.cl/utfsm/Texto-Topograf%EDa/Cap%2009%20Ortofoto.pdf 

 CONSEJERÍA DE MEDIO AMBIENTE Y ORDENACIÓN DEL TERRITORIO, Qué es y 
cómo se hace una Ortofoto, Recuperado el 16 de noviembre del 2018, de 
http://www.juntadeandalucia.es/medioambiente/site/rediam/menuitem.04dc44281e5d5
3cf8ca78ca731525ea0/?vgnextoid=c6fd05464ea09110VgnVCM1000000624e50aRCR
D&vgnextchannel=a76090a63670f210VgnVCM2000000624e50aRCRD&vgnextfmt=re
diam&lr=lang_es 

 Cullen, Imagen urbana y paisaje urbano”. 2012, Conceptualización arq. Recuperado el 
14 de noviembre del 2018, de 
http://conceptualizacionarq.blogspot.com/2012/08/imagen-urbana-y-paisaje-urbano-
por.html 

 EDUSPACE, Tecnología de radar. Recuperado el 14 de noviembre del 2018, de 
http://www.esa.int/SPECIALS/Eduspace_ES/SEMGV7E3GXF_0.html 

 ESRI, ARCMAP. Acerca de las proyecciones cartográficas. Recuperado el 07 de 
noviembre del 2018, de http://desktop.arcgis.com/es/arcmap/10.3/guide-books/map-
projections/about-map-projections.htm 

 Equipo de Trabajo de las Naciones Unidad sobre el Hábitat III (2015), Documento de 
Normas urbanas y legislación. Recuperado el 12 de diciembre del 2018, de 
http://www.caubr.gov.br/wp-content/uploads/2015/08/05.-
Normas_urbanas_y_legislacion_Emerson.pdf 

 Hernández, H.J. (2014). [Documento Digital] Propuesta para el desarrollo de prácticas 
de laboratorio utilizando sistemas de información geográfica, para el curso de topografía 
3, Universidad de San Carlos de Guatemala, Guatemala. Recuperado el 12 de 
noviembre del 2018 de https://es.scribd.com/document/267941406/Propuesta-Para-El-
Desarrollo-de-Practicas-de-Laboratorio-Utilizando-Sistemas-de-Informacion-
Geografica-Para-El-Curso-de-Topografia. 

 INSTITUTO NACIONAL DE ESTADÍSTICA Y GEOGRAFÍA, Imágenes de Satélite, 
elementos de percepción remota. Recuperado el 07 de noviembre del 2018, de 
http://www.inegi.org.mx/geo/contenidos/imgpercepcion/imgsatelite/elementos.aspx 

 INSTITUTO NACIONAL DE ESTADÍSTICA Y GEOGRAFÍA, Ortofoto digital, 
Recuperado el 16 de noviembre del 2018, de 
http://www.inegi.org.mx/geo/contenidos/imgpercepcion/ortofoto/descripcion.aspx 

 PERFIL TOPOGRAFÍA, Fotogrametría: definición y usos. Recuperado el 12 de 
noviembre del 2018, de http://perfiltopografia.es/fotogrametria-definicion-y-usos/. 

 Puerta Tuesta, Ronald, Rengifo Trigozo, Juan, Bravo Morales Nino, (2011), 
[Documento Digital] ArcGIS Básico 10, Esri. Recuperado el 06 de diciembre del 2018, 
de https://actswithscience.com/Descargas/ManualArcGis.pdf 

 Salitchev, K. (1979) Cartografía, Pueblo y Educación; Facultad de Geografía de la 
Universidad de La Habana, Cuba. 

https://pro.arcgis.com/es/pro-app/help/data/imagery/ortho-mapping-in-arcgis-pro.htm
https://pro.arcgis.com/es/pro-app/help/data/imagery/ortho-mapping-in-arcgis-pro.htm
http://resources.arcgis.com/es/help/getting-started/articles/026n0000000t000000.htm
http://resources.arcgis.com/es/help/getting-started/articles/026n0000000t000000.htm
http://desktop.arcgis.com/es/arcmap/10.3/main/map/what-is-arcmap-.htm
http://cartomap.cl/utfsm/Texto-Topograf%EDa/Cap%2009%20Ortofoto.pdf
http://www.juntadeandalucia.es/medioambiente/site/rediam/menuitem.04dc44281e5d53cf8ca78ca731525ea0/?vgnextoid=c6fd05464ea09110VgnVCM1000000624e50aRCRD&vgnextchannel=a76090a63670f210VgnVCM2000000624e50aRCRD&vgnextfmt=rediam&lr=lang_es
http://www.juntadeandalucia.es/medioambiente/site/rediam/menuitem.04dc44281e5d53cf8ca78ca731525ea0/?vgnextoid=c6fd05464ea09110VgnVCM1000000624e50aRCRD&vgnextchannel=a76090a63670f210VgnVCM2000000624e50aRCRD&vgnextfmt=rediam&lr=lang_es
http://www.juntadeandalucia.es/medioambiente/site/rediam/menuitem.04dc44281e5d53cf8ca78ca731525ea0/?vgnextoid=c6fd05464ea09110VgnVCM1000000624e50aRCRD&vgnextchannel=a76090a63670f210VgnVCM2000000624e50aRCRD&vgnextfmt=rediam&lr=lang_es
http://www.juntadeandalucia.es/medioambiente/site/rediam/menuitem.04dc44281e5d53cf8ca78ca731525ea0/?vgnextoid=c6fd05464ea09110VgnVCM1000000624e50aRCRD&vgnextchannel=a76090a63670f210VgnVCM2000000624e50aRCRD&vgnextfmt=rediam&lr=lang_es
http://conceptualizacionarq.blogspot.com/2012/08/imagen-urbana-y-paisaje-urbano-por.html
http://conceptualizacionarq.blogspot.com/2012/08/imagen-urbana-y-paisaje-urbano-por.html
http://www.esa.int/SPECIALS/Eduspace_ES/SEMGV7E3GXF_0.html
http://desktop.arcgis.com/es/arcmap/10.3/guide-books/map-projections/about-map-projections.htm
http://desktop.arcgis.com/es/arcmap/10.3/guide-books/map-projections/about-map-projections.htm
http://www.caubr.gov.br/wp-content/uploads/2015/08/05.-Normas_urbanas_y_legislacion_Emerson.pdf
http://www.caubr.gov.br/wp-content/uploads/2015/08/05.-Normas_urbanas_y_legislacion_Emerson.pdf
https://es.scribd.com/document/267941406/Propuesta-Para-El-Desarrollo-de-Practicas-de-Laboratorio-Utilizando-Sistemas-de-Informacion-Geografica-Para-El-Curso-de-Topografia
https://es.scribd.com/document/267941406/Propuesta-Para-El-Desarrollo-de-Practicas-de-Laboratorio-Utilizando-Sistemas-de-Informacion-Geografica-Para-El-Curso-de-Topografia
https://es.scribd.com/document/267941406/Propuesta-Para-El-Desarrollo-de-Practicas-de-Laboratorio-Utilizando-Sistemas-de-Informacion-Geografica-Para-El-Curso-de-Topografia
http://www.inegi.org.mx/geo/contenidos/imgpercepcion/imgsatelite/elementos.aspx
http://www.inegi.org.mx/geo/contenidos/imgpercepcion/ortofoto/descripcion.aspx
http://perfiltopografia.es/fotogrametria-definicion-y-usos/
https://actswithscience.com/Descargas/ManualArcGis.pdf


16 | P á g i n a  

 

 Santos, Clavero Daniel (2014). [Documento Digital] Fotogrametría usando plataforma 
aérea UAV. Universidad Politécnica de Cataluña, Cataluña, España. Recuperado el 14 
de noviembre del 2018 de https://core.ac.uk/download/pdf/41806759.pdf 

 Snaider, Patricia. (Publicación en formato digital). Proyecciones Cartográficas y 
Sistemas de Referencia. Revista Geográfica Digital. IGUNNE. Facultad de 
Humanidades. UNNE. Año 7. N° 13. Enero – Junio 2010. Resistencia Chaco. 
Recuperado de: http://hum.unne.edu.ar/revistas/geoweb/default.htm 

 Soria Molina, B. Madeleine. (2014). [Documento Digital] Metodología para ejecución y 
control de calidad para ortofotos, mediante combinación de sensor digital con LIDAR en 
zonas rurales. Universidad Politécnica de Madrid, Madrid, España. Recuperado el 13 
de noviembre del 2018 de 
http://oa.upm.es/30860/1/BERZABETH_MADELEINE_SORIA_MOLINA.pdf 

 TODO EQUIPOS S.A., ¿Qué es fotogrametría?. Recuperado el 12 de noviembre del 
2018, de http://www.topoequipos.com/dem/que-es/terminologia/que-es-fotogrametria 

 Torres, V. ¿Qué estudia la topografía? Recuperado el 16 de noviembre del 2018, de 
https://www.muyinteresante.es/curiosidades/preguntas-respuestas/topografia 

 Valcarce, J. (2013), Ortofotos, Recuperado el 16 de noviembre del 2018, de 
https://digimapas.blogspot.com/2013/09/ortofotos.html 

https://core.ac.uk/download/pdf/41806759.pdf
http://hum.unne.edu.ar/revistas/geoweb/default.htm
http://oa.upm.es/30860/1/BERZABETH_MADELEINE_SORIA_MOLINA.pdf
http://www.topoequipos.com/dem/que-es/terminologia/que-es-fotogrametria
https://www.muyinteresante.es/curiosidades/preguntas-respuestas/topografia
https://digimapas.blogspot.com/2013/09/ortofotos.html

